
Session 1: Introduction to ICT
To write a letter or make a report, we can use a word 
processor on a computer instead of using pen and 
paper. A word processor is a software application that 
helps us to create documents by typing in text, making 
corrections (editing text), arranging it in a neat manner 
(formatting) and printing it.

Advantages of Using a Word Processor
There are many advantages of using a word processor. 
Some of these are:

•	 If you want to add something extra or remove 
some text after getting your report checked by a 
teacher, you can easily do it in a word document.

•	 When making a resume (bio-data), it is important 
not to make any spelling mistakes. A word 
processor helps you check spelling and grammar 
so that you use correct grammar, spelling 
and language.

•	 If you are writing a long report and you need 
to work on it for several days, you can save the 
report and get back to it whenever required. You 
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can also print the document if you have to send a 
hard copy to someone.

•	 You can make the document attractive by adding 
different colours, text styles and text sizes. For 
example, if you want to write the title in a special 
style or if you want to highlight some important 
date, you can do it in a word document.

•	 You can also make a poster using a word processor 
by inserting pictures, bulleted lists, tables, shapes 
and charts easily.

Word Processors Available
Some of the common word processing applications 
available are given in Figure 3.1.

Most of the functions 
of all word processors are 
the same. Here, we will be 
using LibreOffice Writer 
to understand how a word 
processor works. 

Getting Started with LibreOffice Writer
Ubuntu operating system comes with pre-installed 
LibreOffice. Hence, to start LibreOffice Writer in Ubuntu 
(Figure 3.2), simply click LibreOffice Writer icon in the 
launcher on the left-hand side. This will start LibreOffice 
Writer and open a new document (Figure 3.3). Start 
typing to add text in the new document. 

LibreOffice 
Writer

Google 
Docs

Microsoft 
Word

OpenOffice 
Writer

Notepad

Figure 3.1

Figure 3.3 LibreOffice Writer
Figure 3.2 Launch LibreOffice Writer 

in Ubuntu
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Creating a New 
Document
You can create a new 
document in LibreOffice 
Writer by clicking 
the New icon and 
then selecting Text 
Document as shown in 
Figure 3.4. 

You can also use 
the shortcut key Ctrl+n 
to create a new word 
document.

Figure 3.4 Create a new word document

The teacher will facilitate these activities – by showing you the 
E-Learning lesson at  http://www.psscive.ac.in/Employability_
Skills.html. This will include videos and e-content for the above 
topics as well as detailed instructions for some activities below.

Activity 1

Practical Exercise — Getting started with LibreOffice Writer

Material required
Computer with LibreOffice Writer installed

Procedure
1.	 Form groups depending on the number of computers 

available. For example, if there are 40 students and you 
have 5 computers, form 5 groups of 8 students each.

2.	 Start LibreOffice Writer, create a new document and 
type some text in the document. Roll the mouse over 
the various options visible on the screen to explore the 
options available in LibreOffice Writer. Save the file.

3.	 One member performs the activity and the others watch 
and give feedback on what was done correctly and what 
can be improved.

4.	 Then, taking turns, every member of the group performs 
the entire activity at least once.

Activity 2

Practical Exercise — Getting started with Microsoft Word

Material required
Computer with Internet connection to run
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Procedure
1.	 Form groups depending on the number of computers 

available (in the same way as done in Activity 1). 
2.	 Start Microsoft Word. Open a new file and type some 

text. Save the file. The practice session will help you 
carry out the steps. If you make an error, you will be 
prompted with the correct steps. After every action you 
will be automatically moved to the next step.

3.	 One member performs the practice exercise. Others 
watch and give feedback on what was done correctly and 
what can be improved. 

4.	 Then, taking turns, every member of the group  performs 
the entire activity at least once.

A.	 Multiple choice questions

	 1.	 Using a word processor, you can create resumes and 
posters. State whether this is true or false.
(a)	 True
(b)	 False

	 2.	 Which of the following options are word processors? 
Select all the correct options.
(a)	 Google Docs
(b)	 LibreOffice Writer
(c)	 Microsoft Word
(d)	 All of the above

	 3.	 Which shortcut key is used to create a new document?
(a)	 Ctrl+ c
(b)	 Ctrl + n
(c)	 Ctrl + m
(d)	 Ctrl + d

B.	 Subjective question

1.	 List the advantages of using a word processor to write 
a letter.

Check Your Progress

What Have You Learnt?
After completing this session, you will be able to

•	 explain what a word processor is.
•	 list advantages of using a word processor.
•	 identify the software packages available for  

word processing.
•	 use LibreOffice Writer to create a new document.

Notes
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Session 2: Basic Interface LibreOffice 
Writer

Whenever we open LibreOffice Writer we see a default 
screen (as shown in Figure 3.5). This has menu options, 
such as File, Edit, View, etc., which help us perform 
various functions. The toolbar provides icons which are 
a shortcut to some of the commonly used functions. The 
minimise or maximise and close buttons are present at 
the top right corner of the screen. At the bottom left 
there is a Status Bar which gives many details, such as 
word count, page number, style, etc. 

Figure 3.5 LibreOffice Writer — Basic Interface

Status Bar
The Status bar is at the bottom of the window. Use the 
Document View options at the bottom right to change 
the view of the document to a single page, multipage 
or book view. The Zoom in or out bar helps to change 
the size of the text (make it appear bigger or smaller) 
without changing the font size. Other details, such as 
word or character count, page number, language, etc. 
are also present on the left side.

Menu Bar
The menu bar is found at the top of the LibreOffice window 
and has several options, such as File, Edit, View, Insert, 
Format, Styles, Table, Form, Tools, Windows and Help.

Notes
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When we click on a 
particular menu option, a 
sub-menu drops down to 
show various commands 
as shown in Figure 3.6. 
To run a command, click 
menu option, such as File 
and then select an option 
from the sub-menu. For 
example, Save. 

Here are the menu 
options with some of their commands:

•	 File: contains commands that apply to the entire 
document, such as New, Open, Close, Save, 
Print, etc.

•	 Edit: contains commands which are used for 
editing a document. Some of these are Undo, Cut, 
Copy, Paste, Find and Replace, etc. 

•	 View: contains commands used to change the 
display of a document in the LibreOffice Window, 
for example Zoom in/out, Web, Status Bar, 
Ruler, etc.

•	 Insert: contains commands that help to add 
or insert various objects into a document, for 
example, Image, Shape, Chart, Header, Footer, 
Page Number, etc.

•	 Format: contains commands to change the 
look of the text in the document, for example, 
making the text bold, line spacing, aligning text, 
paragraph, etc.

•	 Styles: contains commands which set the common 
style of the document, i.e., it specifies the default 
format of the document. It has commands to 
create a new style, load a style and access the 
Styles and Formatting section.

•	 Table: contains commands to insert or delete a 
table in a document and format it.

•	 Form: contains commands to insert controls, such 
as text box, list box, check box, option, button 
etc., in a document.

Figure 3.6 Menu and Sub-menu (Screenshot)
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•	 Tools: contains functions, such as Spelling and 
Grammar check, Mail merge and Macros, etc.

•	 Window: shows all the open LibreOffice windows 
and allows user to switch to any window by 
clicking on it. It also contains commands to open 
a new window and close an existing one.

•	 Help: contains options to open the LibreOffice 
built-in help or go to online help.

Toolbar
The toolbar is present just 
below the menu bar and 
has icons that directly run 
the command without going 
through the menu. 

There are many toolbars but two are displayed 
by default, the first is the Standard Toolbar and just 
below this is the Formatting Toolbar. The Standard 
Toolbar has commands to create a new file, save a file, 
print a file, insert a table, etc. The Formatting Toolbar 
has commands to change the style of the text, font 
size, paragraph alignment, etc. For example, to make 
text bold, you can simply click the Bold icon on the 
Formatting Toolbar instead of using the menu options. 
To see what a particular icon does, hover your mouse 
over an icon. This will show a tooltip with the command 
as shown in Figure 3.7.

Context Menu	
Another way to perform a function is to 
use Context Menu as shown in Figure 3.8. 
When we press the right mouse button on a 
paragraph or image or any object, a context 
menu is displayed. The options that we see 
in the context menu depend on the object 
that is selected. 

Multiple Ways to Perform a Function
As you can see, there are multiple ways to perform the 
same function. For example, there are four ways to 
make a text bold. 

Figure 3.7 Toolbar – Hover over an icon to see tooltip

Figure 3.8 Context menu
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First select the text that has to be made bold and 
then perform one of the following:

(a)	 Click menu option Format, select Text from 
the drop-down and then select Bold from the 
sub-menu.

(b)	 Click the Bold icon in the Formatting Toolbar
(c)	 Right-click and select Character. This will open 

a Character dialog box. Select Bold from the 
Stylebox and click OK.

(d)	 Press Ctrl+B on your keyboard.
In a similar way, most of the functions in LibreOffice 

can be performed in multiple ways. You can explore the 
menu options and the toolbars or use Help to see how a 
particular function can be performed. 

The teacher will facilitate these activities – by showing you the 
e-learning lesson at http://www.psscive.ac.in/Employability_Skills.
html. This will include videos and e-content for the above topics as 
well as detailed instructions for some activities below.

Activity 1

Practical Exercise — Basic User Interface of LibreOffice Writer

Material required
Computer with LibreOffice Writer installed

Procedure
1.	 Form groups depending on the number of computers 

available. For example, if there are 40 students and you 
have 5 computers, form 5 groups of 8 students each.

2.	 Start LibreOffice Writer and roll the mouse over the 
various toolbar icons visible on the screen to explore 
the options available in LibreOffice Writer. Study each 
of these options in terms of their applications and uses.

3.	 Select some of the menu options to see the  
commands available.

4.	 One member performs the activity and the others watch 
and give feedback on what was done correctly and what 
can be improved.

5.	 Then, taking turns, every member of the group performs 
the entire activity at least once.

Notes
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Activity 2

Getting started with Microsoft Word

Material required
Computer with Internet connection

Procedure
1.	 Form groups depending on the number of computers 

available (in the same way as done in Activity 1).
2.	 The practice session will help you carry out the steps 

to view various tab and ribbon options. If you make 
an error, you will be prompted with the correct steps. 
After every action you will be automatically moved to the 
next step.

3.	 One member performs the practice exercise. Others 
watch and give feedback on what was done correctly and 
what can be improved.

4.	 Then, taking turns, every member of the group performs 
the entire activity at least once.

Check Your Progress
A.	 Multiple choice questions

1.	 Undo, cut, copy and paste are __________ commands.
(a)	 View
(b)	 Edit
(c)	 Styles
(d)	 File

	 2.	 You can change the magnification of the page  
(i.e., make it bigger or smaller) using __________ option.
(a)	 Page indicator
(b)	 Proofing level
(c)	 Zoom bar
(d)	 Help

	 3.	 On the __________ side of the status bar, you can see 
page number and word count in LibreOffice.
(a)	 right
(b)	 centre
(c)	 left
(d)	 middle

	 4.	 Which menu option has the commands Save, Print and 
Close?
(a)	 Insert
(b)	 File
(c)	 Tools
(d)	 Format

Notes
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Session 3: Saving, Closing, Opening and 
Printing Document

When we create a new document, we need to save it 
so that we can open it later and use it for viewing or 
printing. Let us learn how to save a document, close it, 
open an existing document and print it.

Saving a Word Document

1.	 Click on File and then 
click Save or Save 
As.This will open the 
Save As dialog box as 
shown in Figure 3.9.

2.	 Browse to the desired 
folder, type the filename 
(for example, Hello 
World) in the name 
textbox and click on 
Save.

B.	 Subjective question
1.	 List the different ways in which text can be formatted in 

the following ways:
(a)	 Made bold
(b)	 Underlined 
(c)	 Font made bigger in size

After completing this session, you will be able to

•	 explain the basic user interface of LibreOffice Writer.
•	 list the various menu options available in LibreOffice 

Writer.
•	 identify some of the basic icons in the toolbar.
•	 use LibreOffice Help to explore how to perform various 

functions.

What Have You Learnt?

Figure 3.9 Save a document
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When we save a file in LibreOffice it gets a default 
extension as .odt. This means the file we just saved will 
have a name as Hello World.odt. This .odt extension 
shows that this is a LibreOffice Writer document. You 
can save the file in many different formats. For example, 
if you want to save this file as a Microsoft Word file, you 
can select the option in the Save as type dropdown as 
shown in Figure 3.11.

Closing a Word Document
To close a document, click File and then 
Close as shown in Figure 3.12.

Opening an Existing Document
To open an existing (already created) 
document, open File Explorer and browser 
to the folder where you had saved the 
document. You will see the file Hello World.
odt as shown in Figure 3.13. Double click 
the file to open it in the word processor.

Printing a Word Document

1.	 To print a document, click File and then select 
Print as shown in Figure 3.13. This will display a 
Print dialog box as shown in Figure 3.14.

2.	 In the Print dialog box, select the printer that is 
connected to the computer and the number of 
copies you want to print. Click OK. This will print 
the document on paper.

Figure 3.11 Saving fiel with a different type

Figure 3.12 Close a document

Figure 3.10 Save as dialog box
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Figure 3.13 Print a document Figure 3.14 Print a dialog box

The teacher will facilitate these activities – by showing you the 
e-learning lesson at http://www.psscive.ac.in/Employability_
Skills.html. This will include videos and e-content for the above 
topics as well as detailed instructions for some activities below.

Activity 1
Practical Exercise — Saving, Closing, Opening and Printing a 
Document using LibreOffice Writer
Material required
Computer with LibreOffice Writer installed
Procedure

1.	 Form groups depending on the number of computers 
available. For example, if there are 40 students and you 
have 5 computers, form 5 groups of 8 students each.

2.	 Start LibreOffice Writer, create a new document and 
type some text in the document, save the document and 
then print it (make sure printer is connected) and then 
close the document.

3.	 Other students in the group watch and give feedback on 
what was done and what can be improved.

4.	 Taking turns, every student in the group can perform 
the activity.

Activity 2
Saving, Closing, Opening, and Printing a Document using a 
different word processor (Microsoft Word)
Material required
Computer with Internet connection to run e-Learning Lesson
Procedure

1.	 Form groups depending on the number of computers 
available. For example, if there are 40 students and you 
have 5 computers, form 5 groups of 8 students each.

2.	 Start Microsoft Word and create a file to save, close, 
open and print a Microsoft Word document. The practice 
session will help you perform the required steps. 
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Check Your Progress
A.	 Multiple choice questions

1.	 What is the shortcut to save the changes made to an 
existing file?
(a)	 FILE > SAVE
(b)	 INSERT > SAVE
(c)	 HOME > SAVE

	 2.	 What is the shortcut to close a document?
(a)	 FILE > SAVE
(b)	 FILE > CLOSE
(c)	 FILE > EXIT

	 3.	 What is the shortcut to print a document?
(a)	 FILE > EXPORT
(b)	 FILE > SEND
(c)	 FILE > PRINT

B.	 Subjective question
1.	 Give the steps to save a new word document.

After completing this session, you will be able to
•	 save a document in a word processor.
•	 close a document in a word processor.
•	 open a document in a word processor.
•	 print a document in a word processor.

What Have You Learnt?

Session 4: Formatting Text in a Word 
Document

Formatting text means changing the way the text 
appears. Different parts of the text can appear in 
different styles and sizes. You can make the text bold, 
underlined or give it a different colour, to highlight and 
make it look attractive. Let us learn how to format text 
in a document.

3.	 One member performs the practice exercise. Others in 
the group watch and give feedback on what was done 
correctly and what can be improved.

4.	 Taking turns, every student in the group can perform 
the activity.

Notes
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Changing the Text Style and Size
In a document, we can change the font, 
i.e., the style in which text is written. There 
are many styles available. The font drop-
down is present in the toolbar. First select 
the text for which the font style has to 
be changed. Click on the drop-down and 
select the font style you want (as shown in 
Figure 3.15). Similarly, the font size can be 
changed to make it big or small. For example, 
titles usually have a bigger size text.

Making Text Bold, Italic or Underlined
You can make the text appear bold, italic 
or underlined. Select the text that you want 
to change and click on the different icons 
present in the toolbar to change the text 
as shown in Figure 3.16. You can also use 
the given shortcut keys on your keyboard 
to change the text.

Bold: Ctrl+B

Italic: Ctrl+I

Underline: Ctrl+U

Aligning Text
The text can be aligned to the 
left, right or center. Select the 
text to be aligned and use the 
icons as shown in Figure 3.17 to make the text appear 
to the left, center or right of the page.

Cut, Copy and Paste Text
The text can be copied from one part of 
the document to another part. To do so, 
first select the text that has to be copied by 
clicking on the given copy icon as shown in 
Figure 3.18. You can also use the shortcut 
key Ctrl+C. Then, move the cursor to 
where you want to paste the contents and 

Figure 3.15 Changing font style and size

Figure 3.16 Making text bold, italic or underlined

Figure 3.17 Aligning text

Figure 3.18 Cut, Copy and Paste icons
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click the Paste icon or Ctrl+V. This copies the text to 
the new location. The text remains in the original place 
too, as it is. 

If you want to delete or remove the text from the 
original place and move it to a new position in the 
document, first, select the text. Use the Cut icon on the 
toolbar or use the Ctrl+X shortcut key. When you do so, 
the text vanishes from the original place. Now place the 
cursor in the new location and either use the Paste icon 
or the Ctrl+V shortcut key. The deleted text is inserted 
where the cursor was placed. This is also called moving 
the text using the cut/paste method.

Find and Replace Text
To find and replace text, click on the icon in 
the toolbar as shown in Figure 3.19. This 
displays a Find & Replace dialog box. You 
can type the text you are looking for and 
just find it. You can also replace the text 
with another text. You can find and replace 
all the matching text in the document in 
one go by clicking Replace All or you can 
find or replace it one by one.

The teacher will facilitate these activities – by showing you the 
e-learning lesson athttp://www.psscive.ac.in/Employability_
Skills.html. This will include videos and e-content for the above 
topics as well as detailed instructions for some activities below.

Activity 1

Practical Exercise — Formatting text using LibreOffice Writer

Material required
Computer with LibreOffice Writer installed

Procedure
1.	 Form groups depending on the number of computers 

available. For example, if there are 40 students and you 
have 5 computers, form 5 groups of 8 students each.

2.	 Open a file in LibreOffice Writer. A member of the group 
changes the text style to Times New Roman and font size 
12. The other member changes the font size to 14.

3.	 Another member aligns the text to the middle, left  
and right. 

Figure 3.19 Find and Replace
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A.	 Multiple choice questions

	 1.	 Priya wants to change the spelling of a word in the 
entire document. Which option will she use?
(a)	 Copy	 (b)	 Align Left

	 (c)	 Find & Replace	 (d)	 Paste

4.	 Others would copy the first paragraph and paste it at the 
end of the text.

5.	 Taking turns, a different set of students repeat the 
activity ensuring every student performs at least one 
formatting task.

6.	 See Figure 1 and Figure 2 to see how your document 
should appear.

Activity 2

Formatting text using Microsoft Word

Material required
Computer with Internet Connection

Procedure
1.	 Form groups depending on the number of computers 

available. For example, if there are 40 students and you 
have 5 computers, form 5 groups of 8 students each.

2.	 Start the Microsoft Word. Change the text style, font 
size, font style, etc. Also perform text alighnment, as was 
done in Activity 1. 

3.	 In each group, one member performs the practice 
exercise while the others watch and give feedback on 
what was done correctly and what can be improved.

4.	 Taking turns, every student in the group performs  
the activity.

Figure 2 Formatted textFigure 1 Unformatted text

Check Your Progress

Notes
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	 2.	 Which of the following statements is true?
(a)	 You cannot replace all matching words with another 

word in one go
(b)	 You can align text in the center 
(c)	 When we use cut and paste, the text appears in both 

the places

	 3.	 In Figure 3, identify which option is used to the  
align text?

Figure 3 Toolbar

B.	 Subjective question

1.	 List the steps to be performed to move the text from one 
location to another in a document.

After completing this session, you will be able to

•	 change the text style.
•	 align text.
•	 cut, copy and paste text.
•	 find and replace text.

What Have You Learnt?

Session 5: Checking Spelling and Grammar

Using correct spellings and grammar when writing 
a letter is important. When we write official letters 
or make a bio-data to apply for a job, it is especially 
important that we use correct language. Normally 
we check manually by reading the letter again. Word 

processors provide a tool to check spellings 
and grammar errors. 
	 As you can see in Figure 3.20, some 
of the words are underlined by a red wavy 
line and some with a blue wavy line. The 
red wavy line shows that word is not spelt 
correctly. The blue wavy line shows that 
there is a grammatical mistake. 

The spell checker helps to correct  
these mistakes. Figure 3.20 Check spelling icon
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Starting the Spell Checker 
To start the spell checker in LibreOffice 
Writer, click the ‘Check Spelling’ icon on the 
toolbar as shown in Figure 3.20 or press F7 
on the keyboard. 

You can also start the spelling checker 
from the menu options as shown in Figure 
3.21. Click Tools and then Spellings. 
When we start the spelling checker in 
LibreOffice Writer, it displays a Spelling 
dialog box as shown in Figure 3.22.

Spelling Dialog Box Options 
It highlights the word with the wrong 
spelling in red. You can choose from 
the different options, what you want to 
do with the highlighted word. 

Some of the commonly used options are:
(i)	  Ignore Once: This will leave the word in the 

text as it is and not change it. We usually 
use this option when some names appear as  
incorrect words. 

(ii)	  Ignore All: This will ignore the presently 
highlighted word and then not highlight if this 
same word appears again anywhere in the text. 
Sometimes a name appears again and again in 
the text. You can either ignore one at a time or 
you can simply click on Ignore All.

(iii)	  Add to Dictionary: Suppose you use a particular 
name in every document, for example, the name 
of a company, then it is best to add it to the 
dictionary. If you do so, then even if you use it 
in a new document, it will not be highlighted 
as incorrect.

(iv)	  Correct: You can select the correct spelling of 
the word from the Suggestions list and then 
click Correct. This will change the spelling of the 
highlighted word to the selected one. 

Figure 3.21 Spelling menu option

Figure 3.22 Spelling checker dialog box
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(v)	  Correct All: If you click on this, 
it will correct the spelling of all 
occurrences of the highlighted 
word and change all of them to 
the suggestion selected.

Shortcut Menu for Spell Checker
Another way to correct the spellings and 
grammar is to select the underlined text 
and right-click. This displays a shortcut 
menu as shown in Figure 3.23 with a 
list of suggested words along with the 
various options present in the Spelling 
dialog box, such as Ignore, Ignore All, 
Add to Dictionary, etc. 

Autocorrect Option
We can set the Automatic Spell 
Checking option on or off by clicking 
Tools>Automatic Spell Checking 
(as shown in Figure 3.24) or pressing 
Shift+F7 on the keyboard. If this is off, 
then we do not see the red and blue wavy 
lines that highlight the incorrect text.

Figure 3.23  Spell Check Options on right-click

Figure 3.24  Automatic Spell Checking

The teacher will facilitate these activities – by showing you the 
e-learning lesson athttp://www.psscive.ac.in/Employability_
Skills.html. This will include videos and e-content for the above 
topics as well as detailed instructions for some activities below.

Activity 1

Practical Exercise — Checking Spelling and Grammar Using 
LibreOffice Writer

Material required
Computer with LibreOffice Writer installed
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Procedure
1.	 Form groups depending on the number of computers 

available. For example, if there are 40 students and you 
have 5 computers, form 5 groups of 8 students each.

2.	 Type in some text in LibreOffice Writer as given in 
Figure 1.

3.	

Dr A P J Abdul Kalam National Memorial was 
established in the memory of the late President Dr A P J 
Abdul Kalam. The memorial is situated at Pei Karumbu, 
in the island town of Rameswaram, in the state of 
Tamil Nadu, India. This Memorial was inaugurated on 
July 27, 2017, by the Prime Minister of  India,   Shri 
Narendra Modi. The memorial was built by Defence 
Research & Development Organisation (DRDO).

One member opens the Spellings dialog box and uses 
the various options available to correct the spellings.

4.	 Another member right-clicks on the incorrect word and 
uses some of the options in the shortcut menu to correct 
it. Turn on/off the Automatic Spell Checking option to 
see how the text appears.

5.	 Others watch and give feedback on what was done 
correctly and what can be improved. Then taking turns, 
another set of students perform the activity ensuring 
that every student performs at least one task.

Activity 2

Practical Exercise — Checking Spelling and Grammar Using 
Microsoft Word
Material required
Computer with Internet Connection
Procedure

1.	 Form groups depending on the number of computers 
available. For example, if there are 40 students and you 
have 5 computers, form 5 groups of 8 students each. 

2.	 Start Microsoft Word and open a file with text. Go to 
Review option. Click on the spell checker icon and check 
the spelling mistakes. On the right-hand side of the 
page, you will see the various options, such as change, 
change all, ignore, ignore all and add. Use these options 
and observe the change.

3.	 One member performs the exercise. Others watch and 
give feedback on what was done correctly and what can 
be improved.

4.	 Then taking turns, every student in the group performs 
the activity.

Notes
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After completing this session, you will be able to

•	 identify the spellings and grammar mistakes in a document.
•	 correct the spellings and grammar mistakes in a document.
•	 turn on or off the Autocorrect feature.

Session 6: Inserting Lists, Tables, Pictures, 
and Shapes 
When we need to make a list of books available in the 
library or a list of ingredients or, any kind of list, we use 
numbers or some symbol (sign) to identify each item. All 
word processors provide a way to create numbered or 
bulleted lists (refer Figures 3.25 and 3.26). We can also 
insert tables in a word document if we want to show 
data in a rows and columns format.

Inserting Bulleted Lists
To create a bulleted list, first write the items of the list in 
different lines. Select all the items, click Format. From 

A.	 Multiple choice questions
	 Read carefully all the options given below the question 

and choose the correct option (s).

1.	 Which menu option will you use to start the spell 
checker in LibreOffice Writer?
(a)	 Tools>Spelling
(b)	 Tools>Automatic Spell Checking
(c)	 Tools>Language	
(d)	 Tools>Options

	 2.	 Which shortcut key will you use to start the Spell 
Checker?
(a)	 F5	 (b)	 F1	 (c)	 F7	 (d)	 F9

	 3.	 Ravi wrote an article on the benefits of sports. But 
everywhere he spelt the word sports as spots. Which 
option in the Spelling dialog box will you use to change 
all the wrong words to the right one in one go?
(a)	 Correct	 (b)	 Always Correct
(b)	 Add to Dictionary	 (d)	 Correct All

	 B.	 Subjective question
1.	 What can you do to make the Spell Checker see your 

name as a correct word and not highlight it as an error 
in any document?

Check Your Progress

What Have You Learnt?

Notes
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the menu options, select Lists and then click Bulleted 
List as shown in Figure 3.25. This will create a bulleted 
list as shown in Figure 3.26. You can also create a 
bulleted list in LibreOffice Writer by selecting all the 
items and then pressing Shift+F12 on the keyboard. 
Please note – the shortcut keys may be different in other 
word processing software.

Figure 3.25 Creating Bulleted List Figure 3.26 A Bulleted List

Figure 3.27 Creating Bulleted List Figure 3.28 A Numbered List

Inserting Numbered Lists
To create a numbered list, first write the items of the 
list in different lines. Select all the items, click Format. 
From the menu options, select Lists and then click 
Numbered List as shown in Figure 3.27. This will  
create a bulleted list as shown in Figure 3.28. You can 
create a numbered list by pressing F12 in the keyboard. 
Please note – the shortcut keys may be different in other word 
processing software.

Using Tables
Tables are used to show data in a tabular format; for 
example, to show the data of students and their marks 
in each subject, we can use tables. We may need to 
have tables in a document, such as when making a 
report card.
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Word processors provide a feature that 
helps us insert tables to show such data.

Inserting a Table
To insert a table in LibreOffice Writer 
document, click the Insert Table icon as 
shown in Figure 3.29 or press Ctrl+F12 on 
your keyboard. Click More Options… from 

the drop-down. 
This opens an Insert Table dialog box as shown in 

Figure 3.30. Select the number of columns and rows 
you want in the table and click Insert. By default, 
the word processor will create a blank table with  
2 columns and 2 rows (refer Figure 3.31).

You can then enter data into this table as shown 
in Figure 3.31.

Figure 3.31

Inserting Pictures
To insert an image, click Insert and then Image as 

shown in Figure 3.32. This will open the Insert Image 
dialog box. Select the image file you want 
to insert into a document and then click 
Open. This will insert an image into the 
document.

Inserting Shapes
To insert a shape in a document, click 

Insert and then Shape. This will open a sub-menu with 
the basic shapes. Select one option 
— for example, Basic. This will 
further show several basic shapes 
such as Rectangle, Circle, Square 
etc. as shown in Figure 3.33 Select 
a shape and then click and drag 
the mouse to specify the size of the 
shape. This will insert a shape into 
the document.

Figure 3.32 Inserting an image

Figure 3.33 Inserting a shape

Figure 3.29 Insert Table icon

Figure 3.30 Insert Table dialog box
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The teacher will facilitate these activities – by showing you the 
e-learning lesson athttp://www.psscive.ac.in/Employability_
Skills.html. This will include videos and e-content for the above 
topics as well as detailed instructions for some activities below.

Activity 1

Practical Exercise — Inserting Lists and Tables Using LibreOffice 
Writer

Material required
Computer with LibreOffice Writer

Procedure
1.	 Form groups depending on the number of computers 

available. For example, if there are 40 students and you 
have 5 computers, form 5 groups of 8 students each. 

2.	 Start LibreOffice Writer or MS Word and in each group, 
one member creates a bulleted to-do-list.

3.	 Another member creates a numbered shopping list. 
Another member then creates a table with names of all 
members in the group and their addresses.

4.	 Others watch and give feedback on what was done 
correctly and what can be improved.

5.	 Then taking turns, another set of students perform the 
activity ensuring that every student performs at least 
one task.

A.	 Multiple choice questions
	 Read carefully all the options given below the question 

and choose the correct option (s).

1.	 What is the correct sequence of steps required to create 
a bulleted list in LibreOffice Writer?
(a)	 Bulleted List > Format > Lists
(b)	 Format > Bulleted List > Lists
(c)	 Format > Lists > Bulleted List
(d)	 Lists>Format>Bulleted List

	 2.	 Which shortcut keys will you use to insert a table in a 
LibreOffice Writer document?
(a)	 F12	 (b)	 Ctrl+F12	 (c)	 F7	 (d)	 F9

	 3.	 Which shortcut key is used in a LibreOffice Writer 
document to create a numbered list? 
(a)	 Ctrl+F12			  (b)	 Shift+F12

	 (c)	 F12			   (d)	 None of the above

Check Your Progress

Notes
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Figure 3.37 Footer

Figure 3.36 Inserting a footer

Figure 3.34 Inserting a header

Figure 3.35 Header

B.	 Subjective question

1.	 What is a list and how do we create a list in a 
word processor?

After completing this session, you will be able to

•	 create a bulleted list.
•	 create a numbered list.
•	 insert a table.

What Have You Learnt?

Session 7: Header, Footer and Page Number

Header is the top part of a page while the footer appears 
at the bottom of the page. They contain information 
that is available on every page at the same place, for 
example, if we want the title of the document at the top 

of each page and the page number at the 
bottom of each page, we can use a header 
(for title) or a footer (for page number).

Inserting a Header
In LibreOffice Writer, to insert a header, 
first click Insert menu option. Click 
Header and Footer in the drop-down 
(Figure 3.34), then Header and then click 
Default Style. 

A header will be created at the top of 
each page as shown in Figure 3.35. Click 
the top part of the document to highlight 
the header. 

Inserting a Footer
Similarly, a footer can be created at the 
bottom of each page.

To insert a footer, click Insert menu. 
Then click Header and Footer, then 
Footer and then click Default Style as 
shown in Figure 3.36. 

A footer as shown in Figure 3.37 is created at the 
bottom of each page. Click the bottom part of the 
document to highlight the footer.
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Figure 3.38 Inserting page number in header or 
footer

Insert Title, Page Number and Page Count
You can insert page numbers, title, page count, date, 
time, subject, etc., into the header or footer. Then it will 
appear on all the pages.

To insert page numbers to your 
pages, first click on the footer. Then 
click the Insert menu option. Click 
Field in the drop-down and then click 
Page Number as shown in Figure 3.38.

This will insert a page number at 
the bottom of every page. Similarly, 
you can insert other details, such as 
date, time, image, etc., into the header 
or footer.

The teacher will facilitate these activities – by showing you the 
e-learning lesson athttp://www.psscive.ac.in/Employability_
Skills.html. This will include videos and e-content for the above 
topics as well as detailed instructions for some activities below.

Activity 1

Practical-exercise — Add Header, Footer and Page Numbers 
using LibreOffice Writer

Material required
Computer with LibreOffice Writer

Procedure
1.	 Form groups depending on the number of computers 

available. For example, if there are 40 students and you 
have 5 computers, form 5 groups of 8 students each.

2.	 Type in 2–3 pages of text in LibreOffice Writer.
3.	 Write 3–5 lines about your last summer holidays. In each 

group, one member adds a header with title as ‘Summer 
Holidays’ and another group member adds a footer with 
page numbers.

4.	 Others in the group watch and give feedback on what 
was done correctly and what can be improved.

5.	 All other group members repeat the exercise on a fresh 
document.
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A.	 Multiple choice questions

1.	 Which of the following statement is true?
(a)	 Headers are text or images inserted in the bottom 

margin.
(b)	 If you insert a footer in one page, it will appear on all 

pages.
(c)	 Headers are used to insert borders in a document.
(d)	 You cannot insert date, time, page number, etc., in a 

header or footer.
	 2.	 Which of the given options can you add to a header?
	 (a)	 Page number	 (b)	 Date
	 (c)	 Title	 (d)	 All of these
	 3.	 Ravi wrote a long document for his research and gave it 

to his professor. He wanted his professor to review only 
the ‘Field Study’ section of the document. How does he 
easily and correctly tell his professor where to find the 
‘Field Study’ section? 
(a)	 Tell him that it is somewhere in the middle of the 

document    
(b)	 Type in the page number in each page manually and 

tell him the page number
(c)	 Insert page number in the footer and tell him the 

page number

B.	 Subjective question

1.	 What is the advantage of using a header or a footer in a 
word processor document?

Activity 2

Practical Exercise — Add Header, Footer and Page Numbers 
using Microsoft Word

Material required
Computer with Internet Connection

Procedure
1.	 Form groups depending on the number of computers 

available. For example, if there are 40 students and you 
have 5 computers, form 5 groups of 8 students each.

2.	 Start MS Word. Open a file with a paragraph and go to 
‘Insert’ option. Check on header or footer to insert the 
same. Type the text in the header or footer.

3.	 One member performs the practice exercise. Others 
watch and give feedback on what was done correctly and 
what can be improved.

4.	 Then taking turns, every student in the group performs 
the activity.

Check Your Progress

Notes
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After completing this session, you will be able to
•	 insert a header in a document.
•	 insert a footer in a document.
•	 insert page number(s) in a header or footer.

What Have You Learnt?

Session 8: Tracking Changes in LibreOffice 
Writer

Tracking changes in a word document means to keep a 
record of the changes made in a document. For example, 
a student writes a report and gives it to the teacher for 
checking. Just as a teacher makes corrections using a 
red pen in a paper copy, the teacher can make changes 
in a word processor using the Track Changes mode. 
This will highlight the changes and make it easier for 
the students to see and correct their mistakes.

How to Start/Stop Tracking Changes in 
LibreOffice Writer
To start tracking changes in 
LibreOffice Writer, click Edit and 
then click Track Changes.

This will show a sub-menu with 
several options. To start tracking 
changes, the first step is to click 
Record as shown in Figure 3.39 
or press Ctrl+Shift+E. Once you 
click Record, all changes made to 
the document will be recorded and 
displayed in a different colour. If you 
want to stop tracking the changes, 
click Record again.

Tracking Options 
With the Record on, all changes are recorded. These are 
displayed in a different colour. Any text that is deleted 
will not disappear, but will appear as strikethrough (or 
cut across with a line, for example change). 

This Track Changes sub-menu provides many 
options. You can move from one change to the other 

Figure 3.39 Tracking Options 

Figure 3.40 Tracking Options 
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using the Next and Previous options (refer Figure 3.40). 
When a change is selected you can accept it or reject 
it using Accept and Reject options. If you accept, the 
change will become a permanent part of the text and if 
you reject, it will revert to the original text. 

If you think all the changes are OK, then you can 
accept them all at once using the Accept All command. 
Similarly, if you do not want to accept any changes and 
want to revert back to the original text, then you can 
use the Reject All option.

Sometimes, we may want to see how the document 
will appear with all the changes accepted without 
actually accepting them. If you click the Show option, 
the document will appear as if the changes have been 
accepted. If you click Show again, the document will 
appear in track mode with the changes.

You can protect the changes by adding a 
password. Click Protect. This will open the 
Enter Password dialog box as shown in Figure 
3.41. Add a password. Now only the person who 
knows this password will be able to accept or 
reject the changes and no one else. 

Manage Option
The Manage option opens the Manage Changes 
dialog box as shown in Figure 3.42. In this all the 
changes are displayed in a list. You can select a 
particular change and accept or reject it. 

You can also click Accept All to accept all 
the changes or Reject All to reject all the 
changes.

Compare Documents
If you click Compare Document…, 
LibreOffice will compare the current file 
with the file you provide. This will then 
open the Manage Changes dialog box with 
a list of all the differences between the two 

files. Here you can accept or reject these differences and 
the current file will get updated accordingly.

Figure 3.41 Enter Password  

Figure 3.42 Manage Options 
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The teacher will facilitate these activities – by showing you the 
E-Learning lesson at http://www.psscive.ac.in/Emplyability_
Skills.html. This will include videos and E-content for the above 
topics as well as detailed instructions for some activities below.

Activity 1

Tracking Changes in LibreOffice Writer

Material required 
Computer with LibreOffice Writer

Procedure
1.	 Form groups depending on the number of computers 

available. For example, if there are 40 students and you 
have 5 computers, form 5 groups of 8 students each.

2.	 Start LibreOffice Writer, create a new document and 
type some text in the document.

3.	 Click on ‘Edit’ and then click on ‘Track Changes’.
4.	 Then another member reviews the document and makes 

changes. The first member can then accept or reject 
the changes. Two members perform the activity and 
the others watch and give feedback on what was done 
correctly and what can be improved.

5.	 Then taking turns, another set of students perform the 
activity ensuring that every student performs at least 
one task.

Activity 2

Tracking Changes in Microsoft Word

Material required
Computer with Internet Connection to Run e-Learning Lesson.

Procedure
1.	 Form groups depending on the number of computers 

available (in the same way as done in Activity 1.
2.	 Start MS Word and open a file. Go to ‘Review’ option and 

click on ‘Track changes’ 
3.	 Now type some text and see the changes.
4.	 One member performs the practice exercise. Others 

watch and give feedback on what was done correctly and 
what can be improved.

5.	 Then taking turns, every student in the group performs 
the activity.

Notes
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After completing this session, you will be able to

•	 explain the need for tracking changes in a word document.
•	 explain how to start and stop the tracking process in 

LibreOffice Writer.
•	 identify the options to accept or reject changes.

A.	 Multiple choice questions

1.	 When you start recording the document, all the changes 
show up as coloured text? State whether this is true or 
false.
(a)	 True	 (b)	 False

	 2.	 If you ________ something when in the ‘track change’ 
mode, it will not disappear but instead will have a 
visible strike through it.
(a)	 Add	 (b)	 Delete	 (c)	 Italicise	 (d)	 Bold

	 3.	 Track changes are suggestions. If you want to make the 
changes permanent you have to __________ them.
(a)	 Underline		  (b)	 Save

	 (c)	 Accept			   (d)	 Reject

B.	 Subjective question

1.	 What is the function of the Manage option?

Check Your Progress

What Have You Learnt?

Notes
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